Introduction to 10 Minute Guide to Microsoft Office 2003

Introduction to 10 Minute Guide to Microsoft® Office 2003
Copyright © 2004 by Que Publishing

All rights reserved. No part of this book shall be reproduced, stored in a retrieval system, or transmitted by any means, electronic, mechanical, photocopying, recording, or otherwise, without written permission from the publisher. No patent liability is assumed with respect to the use of the information contained herein. Although every precaution has been taken in the preparation of this book, the publisher and author assume no responsibility for errors or omissions. Nor is any liability assumed for damages resulting from the use of the information contained herein.

Book Electronic International Standard Book Number: 0768664527

Trademarks
All terms mentioned in this book that are known to be trademarks or service marks have been appropriately capitalized. Que Publishing cannot attest to the accuracy of this information. Use of a term in this book should not be regarded as affecting the validity of any trademark or service mark.

Microsoft is a registered trademark of Microsoft Corporation.

Warning and Disclaimer
Every effort has been made to make this book as complete and as accurate as possible, but no warranty or fitness is implied. The information provided is on an “as is” basis. The author and the publisher shall have neither liability nor responsibility to any person or entity with respect to
Contents

Chapter 1  What's New in Office 2003?  1
  Introducing Microsoft Office 2003 ......................................................1
  Office 2003 and the Document Workspace ........................................2
  Getting Help in Office 2003 .................................................................4
  Using the New Research Feature .........................................................5
  Faxing over the Internet .......................................................................6
  Office 2003 and XML Data ...................................................................7
  Office Instant Messaging .....................................................................8

Chapter 2  Using Common Office Features  10
  Starting Office Applications ...............................................................10
    Starting an Application by Choosing a Document Template ..........10
    Creating Desktop Icons ...................................................................12
  Using the Menu System ......................................................................12
  Using Shortcut Menus .........................................................................13
  Working with Toolbars .......................................................................14
  Understanding Dialog Boxes .............................................................16

Chapter 3  Using Office Task Panes  17
  Understanding the Task Pane .............................................................17
  The Research Task Pane .....................................................................19
  The Basic File Search Task Pane .......................................................20
  Other Standard Task Panes ...............................................................22
    The Clip Art Task Pane .................................................................22
    Using the Office Clipboard .............................................................23
Chapter 4 Using the Office Speech Feature

Training the Speech Feature ................................................................. 25
Using Voice Dictation ........................................................................ 27
Using Voice Commands ...................................................................... 29
A Final Word About the Speech Feature ............................................. 29

Chapter 5 Getting Help in Microsoft Office

Help: What’s Available? ....................................................................... 31
Using the Ask a Question Box ............................................................ 31
Using the Office Assistant .................................................................. 32
  Turning the Office Assistant On and Off ....................................... 32
  Asking the Office Assistant a Question ......................................... 33
Using the Help Task Pane .................................................................. 34
Searching For Help Online ................................................................ 35

Chapter 6 Customizing Your Office Applications

Navigating Options Settings ............................................................... 36
Setting Options in Word ..................................................................... 37
Setting Options in Excel ..................................................................... 39
Setting Options in PowerPoint .......................................................... 41
Setting Special Options in Access ..................................................... 42
Customizing Toolbars ....................................................................... 43

Chapter 7 Using Office Web Integration Features

Adding Hyperlinks to Office Documents ............................................ 46
Saving Office Documents As Web Pages .......................................... 49
Adding an FTP Site to Your Save In Box .......................................... 51

Chapter 8 Faxing and E-Mailing in Office 2003

Understanding E-Mails and Faxes in Office ................................... 53
Using the Word Fax Wizard .............................................................. 54
Sending Faxes from Other Office Applications ............................... 56
Sending E-Mails from Office Applications ...................................... 57
Chapter 1  Upgrading to Outlook 2003 61
What’s New in Outlook 2003? ................................................................. 61
Using the New Navigation Pane .............................................................. 62
Creating Search Folders ......................................................................... 64
Introducing the Business Contact Manager ......................................... 65
Importing E-Mail Accounts and Other Data ............................................. 66

Chapter 2  Upgrading to Word 2003 68
What’s New in Word 2003? .................................................................... 68
Understanding File Format Issues .......................................................... 69
Word and XML Documents ..................................................................... 70
Task Panes and Smart Tags ..................................................................... 71

Chapter 3  Upgrading to Excel 2003 73
Introducing Excel 2002 .......................................................................... 73
Creating Worksheet Lists ...................................................................... 74
Comparing Worksheets Side by Side ....................................................... 75

Chapter 4  Upgrading to Access 2003 77
What’s New in Access 2003? ................................................................. 77
Access File Format Issues ..................................................................... 78
Access Error Checking .......................................................................... 79
Backing Up an Access Database ............................................................. 81

Chapter 5  Upgrading to PowerPoint 2003 82
What’s New in PowerPoint 2003? ......................................................... 82
PowerPoint File Format Issues ............................................................... 82
Packaging a Presentation to a CD ......................................................... 83

Chapter 6  Upgrading to Publisher 2003 85
What’s New in Publisher 2003? ............................................................ 85
Creating E-Mail Publications ................................................................. 86
Publisher File Format Issues ................................................................. 87
What’s New in Office 2003?

In this lesson, you learn about the new features that the Office 2003 application suite provides.

Introducing Microsoft Office 2003

Microsoft Office 2003 is the latest version of the popular Office application suite. Microsoft Office 2003 comes in different editions that include a different set of Office applications. For example, the Microsoft Office Professional Edition, which we cover in this book, includes Word 2003, Excel 2003, PowerPoint 2003, Outlook 2003 with the Business Contact Manager, Publisher, and Access 2003. Table 1.1 provides a look at each of the Microsoft Office 2003 editions.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Applications Included</td>
<td>Word 2003</td>
<td>Excel 2003</td>
<td>PowerPoint 2003</td>
</tr>
<tr>
<td></td>
<td>Excel 2003</td>
<td>Office 2003</td>
<td>with Business Contact Manager</td>
</tr>
<tr>
<td></td>
<td>Publisher 2003</td>
<td>Publisher 2003</td>
<td>Publisher 2003</td>
</tr>
</tbody>
</table>

No matter which edition of Office you use, you are provided with different software applications that you can use to tackle a large variety of business and personal tasks on the computer. For example, Word allows you to create reports, letters, and other documents, and Excel allows you to tackle spreadsheets, invoices, and do a wide
variety of number-crunching tasks. Each application provides a specialized set of
tools and environments for addressing your productivity needs.

Microsoft Office 2003 offers a number of new enhancements to the Office suite. This
lesson serves as a quick overview of some of these new features. Other new features
are highlighted in Part II of the book (“Migrating to Office 2003”). You will also use
some new features as you explore each of the Office applications discussed in this
book.

**Office 2003 and the Document Workspace**

An exciting new feature, the Document Workspace, allows users who don’t have the
option of sharing documents on a corporate network to collaborate on the Web. The
Document Workspace is actually an extension of Microsoft Windows SharePoint
Services, which allows you to store documents for collaboration on a SharePoint
server. Multiple users can access the document in the shared workspace, and tasks
can be assigned associated with the collaborative effort.

The Document Workspace is a fairly advanced feature offered by Office 2003, so the
full details related to the use of this powerful feature are beyond the scope of this
introduction. However, creating a new workspace is surprisingly easy. It does, how-
ever, require that you are connected to the Internet and have access to a SharePoint
server maintained by your company or you have subscribed to a SharePoint hosting
service such as those offered by Microsoft. Let’s take a look at creating a Document
Workspace in Microsoft Word.

To create a Document Workspace, follow these steps (these steps assume Microsoft
Word is already open):

1. Open the document that will be available in the shared workspace.
2. Select **Tools** and then **Shared Workspace**. The Shared Workspace task pane
   opens as shown in Figure 1.1.
3. Type the URL (Uniform Resource Locator or Web address) for the workspace
   that will serve as the holding area for the shared document in the Location for
   New Workspace box.
4. Click the **Create** button in the task pane.
5. A connection box will appear that requires you to enter your user name and
   password for the shared workspace. After entering the information, click OK.
6. The shared workspace will be created (on the Web site you designated) and a
   copy of the current document is placed in the workspace.
Figure 1.1 A shared workspace can be created for your Office documents.

As the creator of the site, you are designated as the site owner. This allows you to add new members to the site, add additional documents, and manage the workspace. You can also view who is currently online and working on the document. Figure 1.2 shows a document that is shared in a workspace. Note that the Shared Workspace task pane lists the current users of the workspace and whether or not they are currently online. Tools provided in the task pane allow you to quickly e-mail workspace users and to update the workspace status.

TIP Tasks Can be Created Using the Shared Workspace Task Pane A useful feature related to the Shared Workspace feature is the ability to create tasks and assign them to users of the workspace. Click the Tasks icon at the top of the Shared Workspace task pane and then click the Add New Task link. To name the task, use the Task dialog box that appears, and set the other task parameters, such as who the task is assigned to and when the task is due.
The Shared Workspace task pane allows you to manage the workspace and its users.

**Getting Help in Office 2003**

Microsoft Office 2003 uses a streamlined Help system that is primarily accessed using the new Help task pane. Options available in previous versions of Office such as the Office Assistant and the Ask a Question box are also available in Office 2003 for accessing help.

You can open the Help task pane by selecting the **Help** menu and then accessing the Help command for the current application. For example, to access the Help task pane in Word, select **Help** and then **Microsoft Word Help**. The Help task pane appears as shown in Figure 1.3.

The Help task pane enables you to search using keywords. You also have access to up-to-date help via Office online. For more about the new Office Help system, see Lesson 5, “Getting Help in Microsoft Office.”
Chapter 1  What's New in Office 2003?

Using the New Research Feature

Another new feature that Office 2003 provides is the Research task pane. The Research task pane allows you to access basic tools such as the Thesaurus, but it also provides you with the ability to access online resources that range from business Web sites, to stock information, to online encyclopedias such as Microsoft’s Expedia.

For example, I might want to search for information on a key term as shown in Figure 1.4. The Research task pane is discussed in more detail in Lesson 3, “Using Office Task Panes,” and in the Word section of the book (Part IV) in Lesson 4, “Using Proofreading Tools.”
Faxing over the Internet

Another addition to Office 2003 is the ability to send faxes from your Office applications over the Internet. This feature requires that you sign up for an Internet fax service. These services provide you with the ability to send and receive faxes over the Internet. This means that you do not require a fax modem on your computer to work with faxes.

Sending the current document from any Office application as an Internet fax is quite easy: You click the File menu, point at Send To, and then select Recipient Using Internet Fax Service. The first time you use this command, you will have the option of being taken to a Web page that allows you to sign up for a fax service. Pricing for this service varies by provider as do the steps required to prepare a fax cover page and send your Office document. Faxing is discussed in more detail in Lesson 8, “Faxing and E-Mailing in Office 2003.”
Office 2003 and XML Data


XML or Extensible Markup Language is a markup language (HTML being an example of another markup language) that can be used to tag data so that it can be transferred between applications and also interpreted and validated. XML is rapidly becoming an important format for moving data between servers on the Web.

Saving in XML format is particularly useful in situations where you want to convert Excel or Access data to an XML format for use on the Web. Although using XML data on the Web is beyond the scope of this book, you will find that if required, you can quickly save data in an Office application such as Excel in the XML format.

Follow these steps:

1. Select File, then Save As. The Save As dialog box will open.
2. In the Save As dialog box, select the Save as Type drop-down box and select XML Data (see Figure 1.5). You can also change the filename if you want.
3. When you have made the necessary changes in the Save As dialog box, click Save.

![Save As dialog box](image)

**Figure 1.5** Office data can be saved in the XML format.
Office Instant Messaging

Microsoft Office XP introduced smart tags to the Office applications. A *smart tag* is a special shortcut menu that provides you with additional options related to a particular feature. There are paste smart tags, AutoCorrect smart tags, and smart tags for dates, times, and addresses that you place in your Office documents. Office 2003 has added a new Person Name smart tag that flags contact names that you have added to your Outlook Contacts list and provides the Windows Messenger address for the contact.

**Make Sure the Person Name Smart Tag Is Active**

The Person Name smart tag must be applied to names in your documents if you want to send instant messages. Select **Tools**, then **AutoCorrect Options**. In the AutoCorrect dialog box, click the **Smart Tags** tab and make sure that the **Person Name (English)** smart tag has a check mark next to it.

For example, if you create a document that includes the person’s name, the name will be flagged with the Person Name tag (the name will be underlined with a dashed red line). Point at the name and click the smart tag icon that appears (the icon looks like the Windows Messenger icon, see Figure 1.6). On the menu that appears, select **Send Instant Message**.

![Smart tag icon](image)

**Figure 1.6** Send instant messages directly from your Office applications using the Person Name smart tag.
Chapter 1  What's New in Office 2003?

A Windows Messenger window will open. You can now send your instant message as needed.

**Your Message Recipient Must Be Online**  To send an instant message to a person using the new Person Name smart tag, that person must currently be online using Windows Messenger. If they are not online, the Send Instant Message menu choice is not available.
Using Common Office Features

In this lesson, you learn how to use common Office features such as menus, toolbars, and dialog boxes.

Starting Office Applications

The Microsoft Office applications can be quickly started from the Windows Start menu. Desktop icons can also be quickly created for an Office application to provide quick access to that application.

To start an Office application from the Start menu, follow these steps:

1. From the Windows XP desktop, click Start, point at All Programs, and then point at the Microsoft Office folder. The Office programs installed on your computer will appear as shown in Figure 2.1 (for Windows 2000, point at Programs, then Microsoft Office).

2. To open a particular Office application, click that application’s icon on the menu. The program window for that application appears.

Starting an Application by Choosing a Document Template

You can also start a particular Office application by choosing the type of Office document that you are going to create. This is done using the Start menu.

1. From the Windows desktop, click Start, All Programs, then New Office Document. The New Office Document dialog box appears (see Figure 2.2).

2. All the Office application templates are available on the different tabs of the New Office Document dialog box. You can create blank documents or special documents from the templates that are provided (specific templates are discussed in more detail in the various parts of this book as they relate to a particular Office application). Select a particular template in the dialog box.
Figure 2.1  Use the Start menu to start your Office applications.

Figure 2.2  The New Office Document dialog box can be used to quickly start a new document in any Office application.

3. Click OK. The application that uses that particular template opens (such as Word if you select the Blank Document icon), and the new document appears in the application window.
Creating Desktop Icons
You can also create shortcut icons for your Office applications on the Windows desktop. To create desktop icons for Office applications, follow these steps:

1. From the Windows desktop, click Start and then point at All Programs, Microsoft Office.
2. Right-click the Office application icon that you want to use to create the desktop icon.
3. Select Copy from the shortcut menu that appears.
4. Click anywhere on the desktop to close the Start menu.
5. Right-click the Windows desktop and select Paste Shortcut from the shortcut menu that appears.

A desktop icon for the selected application appears on the Windows desktop. You can double-click the icon to start the specific application. You can also use the steps discussed in this section to create shortcut icons for your other programs (including non-Office applications), as needed.

**TIP** More Shortcuts You can also pin an application to the Start menu in Windows XP. This provides quick access to the application. Right-click on a Start menu icon and select Pin to Start menu.

Using the Menu System
The menu bar that you find in the Office applications gives you access to all the commands and features a particular application provides. These specific menu systems are found below the title bar and are activated by selecting a particular menu choice. The menu then opens, providing you with a set of command choices.

The Office 2003 applications use a personalized menu system that was first introduced in Microsoft Office 2000. It enables you to quickly access the commands you use most often. When you first choose a particular menu, you find a short list of menu commands. As you use commands, the Office application adds them to the menu list.

To access a particular menu, follow these steps:

1. Select the menu by clicking its title. The most recently used commands appear; hover the mouse pointer for just a moment and all the commands on a particular menu appear; if you don’t like to hover, click the Expand icon (the double down-pointing arrow on the bottom of the menu) to view all the menu choices.
2. Select the command on the menu that invokes a particular feature.

You will find that several of the commands found on the menu are followed by an ellipsis (…). These commands, when selected, open a dialog box or a task pane. Dialog boxes require you to provide the application with additional information before the particular feature or command can be used (more information on working with dialog boxes appears later in this lesson).

Some of the menus also contain a submenu or a cascading menu that you can use to make your choices. The menu commands that produce a submenu are indicated by an arrow to the right of the menu choice. If a submenu is present, you point at the command (marked with the arrow) on the main menu to open the submenu.

**Activating Menus with the Keyboard**

You can also activate a particular menu by holding down the `Alt` key and then pressing the keyboard key that matches the underscored letter, also called a hotkey, in the menu’s name. For example, to activate the File menu in Office applications, press `Alt+F`.

If you would rather have access to all the menu commands (rather than just those you’ve used recently), you can turn off the personalized menu system. To do this, follow these steps in any Office application:

1. Click the **Tools** menu, and then click **Customize**.
2. In the Customize dialog box, click the **Options** tab.
3. To show all the commands on the menus (without delay), click the **Always Show Full Menus** check box.
4. Click **OK** to close the dialog box.

**Using Shortcut Menus**

A fast way to access commands that are related to a particular item on an Office document, such as selected text or a picture, is to right-click that item. This opens a shortcut menu that contains commands related to the particular item with which you are working.

For example, if you select a chart on an Excel worksheet, right-clicking the chart (see Figure 2.3) opens a shortcut menu with commands such as Cut, Copy, and Paste.

You will learn about shortcut menus as you work with the Office applications in the various parts of this book.
Shortcut menus provide quick access to application commands.

As you learned in Lesson 1, some items in your Office application documents are also marked with smart tags. Pointing at an item underscored with a dotted red line allows you to access the smart tag menu and access options related to that document item, such as a pasted item.

**Working with Toolbars**

Toolbars provide you with a very quick and straightforward way of accessing commands and features in the Office applications. When you first start one of the Office applications, you typically see the Standard and Formatting toolbars sharing one row, as shown in Figure 2.4.

To access a particular command using a toolbar button, click the button. Depending on the command, you see an immediate result in your document (such as the removal of selected text when you click the Cut button), or a dialog box might appear, requesting additional information from you.

**Finding a Toolbar Button’s Purpose** You can place the mouse pointer on any toolbar button to view a ScreenTip that describes that tool’s function.
Chapter 2 Using Common Office Features

Figure 2.4 Toolbars, such as the Standard and Formatting toolbars in this PowerPoint window, provide quick access to an application’s features and commands.

Other toolbars, such as the Drawing toolbar and toolbars that are specific to a particular Office application, open when you access a particular application. You can also open them manually by right-clicking any visible toolbar and then selecting the toolbar you want to use from the list that is provided. You can also use this method to close a toolbar you no longer need.

Missing Toolbar Buttons? The Standard and Formatting toolbars have been configured to share one row by default, so you might not be able to see every button on the toolbars. To find a hidden button, click the More Buttons button on the end of either toolbar. Another alternative is to click the Toolbar Options button on the Standard or Formatting toolbar and select Show Buttons on Two Rows. This gives each toolbar its own row.

In Lesson 6, “Customizing Your Office Applications,” you learn how to customize common Office features. We will work with toolbar settings and other options related to the various application settings.
Understanding Dialog Boxes

When you are working with the various commands and features found in Office applications, you will invariably come across dialog boxes. Dialog boxes are used when an Office application needs more information from you before it can complete a particular command or take advantage of a special feature. Dialog boxes always appear when you select a menu command that is followed by an ellipsis. Dialog boxes also appear when you invoke this same command using the appropriate toolbar button.

Figure 2.5 shows Word’s Font dialog box. This dialog box enables you to make selections using check boxes and drop-down lists. Other dialog boxes use option buttons, spinner boxes, and other methods of enabling you to quickly make selections in a particular box.

In most cases, when you complete your selections in a dialog box, you click the OK button to close the box and complete the command. You also have the option of clicking the Cancel button if you want to close the dialog box without saving any changes you made.
Using Office Task Panes

In this lesson, you learn how to use Office 2003’s task panes.

Understanding the Task Pane

A major change to the previous version of Office, Office XP, was the introduction of task panes. Office 2003 also uses task panes, which have replaced many of the dialog boxes that were a common feature in Office 97 and Office 2000. Office 2003 has also added new task panes such as the Research task pane (which we discuss later in this lesson).

A task pane is a multipurpose window pane that appears on the right side of the window of an Office application. The list that follows describes the global task panes that you will find in all the Office applications:

- **New File Task Pane**—Enables you to start a new file in a particular application (for example, in Word it is called the New Document task pane; in Excel it is called the New Workbook task pane). It also provides access to various document templates and the capability to open recently used files.

- **Office Clipboard Task Pane**—Enables you to view items that you copy and cut to the Office Clipboard. You can manage up to 24 items on the Clipboard and paste them within an application or between applications.

- **Clip Art Task Pane**—Enables you to search the Office Clip Gallery and insert clip art into your Office application documents.

- **Search Task Pane**—Enables you to search for files from any of the Office applications.

- **Research Task Pane**—This new task pane allows you to take advantage of a number of research and reference services. A number of these references are accessed via online services such as Microsoft Encarta.

You look at the Research, Search, Clip Art, and Clipboard task panes in more detail later in the lesson.
Task panes also house features that handle specific purposes in each of the Office applications. For example, in PowerPoint, the Slide Layout task pane (shown in Figure 3.1) is used to select a design format for a new or existing PowerPoint presentation slide. You learn about the different task panes in the Office applications as you use them in the different parts of this book.

Figure 3.1 The task pane provides specific features in the different Office applications.

When you are working in an Office application, such as Word or Excel, you can open a task pane and switch between the different task pane features offered in that particular application. To open a task pane, follow these steps:

1. In the Office application window, select the View menu and select Task Pane. The New File task pane appears on the right side of the application window (the New File task pane is the default task pane for the Office applications).
2. To switch to a particular task pane that is available in the current Office application, click the task pane’s drop-down arrow (see Figure 3.2).
3. Click the item on the task pane menu that you want to use.

You will find that the task pane also pops up when you select specific features in an application. For example, in Word, when you select Format and then Styles and Formatting, the Styles and Formatting task pane appears in the Word window.
Chapter 3 Using Office Task Panes

Figure 3.2 Use the task pane’s menu to switch to a particular task pane in an application.

TIP Help Is Now a Task Pane Office Help is now accessed through a task pane. Getting help in Office is discussed in Lesson 5, “Getting Help in Microsoft Office.”

The Research Task Pane

The newest Office task pane is the Research task pane. The Research task pane provides a tool that can be used to access all sorts of information related to a selection in a Word document, Excel worksheet, or PowerPoint Presentation. These tools can be standard tools such as the Thesaurus and can also consist of specialized data sources created to find specific kinds of information. For example, Figure 3.3 shows the results of a Research task pane search for the term “Microsoft.” The results provide company information including employee numbers and yearly revenue.

To use the Research task pane, follow these steps:

1. From an Office application window, select the term or phrase that will be used in the Research task pane search.
2. Select the View menu and then select Task Pane to open the task pane.
3. Select the task pane drop-down arrow and select Research. The Research task pane will open.
4. Your selected term or phrase will appear in the Search For box.
Figure 3.3 The Research task pane can be used to find a variety of information from any Office application.

5. Click the Services drop-down list and select the research services you want to use for the search. You can select All Research Sites, Factiva News Search, All Business and Financial Sites, and a number of other resource services.

6. After selecting the service or services, the search will be performed. A list of found information will appear in the task pane.

7. To switch from the initial source to the next source (found in the search), click Next.

8. To expand any of the found information, click the plus symbol next to a source heading.

If you want to conduct another search, type the keyword or phrase in the Search For box and then click the green Search arrow. Results are returned in the task pane. When you have finished working with the Research task pane, click the Close button to close it.

The Basic File Search Task Pane

The Basic File Search task pane enables you to locate files stored on your computer or company network without leaving the Office application that is currently open. To use the Search task pane, follow these steps:
1. From an Office application window, select the File menu and then select Search to open the Search task pane (see Figure 3.4).

![Search task pane](image)

**Figure 3.4** Use the Search task pane to locate files on your computer or network.

2. Type the keyword or keywords that you want to use for the search into the Search text box.

3. To specify the locations that should be searched, click the Selected Locations drop-down box. You can expand any of the locations listed, such as My Computer, by clicking the plus (+) symbol to the left of the location. This enables you to view folders and subfolders at that location. Use the check boxes to the left of each location to specify whether that location should be searched.

4. To specify the types of files that are located during the search, click the Selected File Types drop-down list. Select or deselect the check boxes for particular Office applications (such as Word or Excel) to specify the types of files that should be included in the search.

5. When you are ready to run the search, click the Go button.

The files that meet your search criteria appear in the Search task pane. To open one of the files (in the application that it was created in), click the filename.
You can also click the Advanced Search link in the Search task pane to run an advanced search. The Advanced Search task pane enables you to create a search that uses conditional statements and allows you to search by file type, the date that the file was last modified, and a number of other parameters.

Other Standard Task Panes
Two other standard task panes that you will probably use a lot are the Clip Art and Office Clipboard task panes. Although using these task panes is covered within the context of specific Office applications in the parts of this book, you can take a brief look at both of them in the following sections.

The Clip Art Task Pane
How you find and insert clip art in the Office applications has been made much easier by the introduction of the Clip Art task pane. This task pane enables you to quickly search for clip art using a keyword search. Clip art that matches your search parameters is then immediately shown in the Clip Art task pane as thumbnails.

To use the Clip Art task pane, follow these steps:

1. In an Office application such as Word or Excel, select Insert, point at Picture, and then select Clip Art. The Clip Art task pane appears (see Figure 3.5).

![Figure 3.5](image)

Figure 3.5  Search for clip art by keywords using the Clip Art task pane.
Chapter 3  Using Office Task Panes

2. In the task pane’s Search For box, type keywords that Office can use to find your clip art images.

3. Use the Search In drop-down box to specify the collections you want to include in the clip art search. Selected collections are marked with a check mark in their check box that you can toggle on and off with a simple click of the mouse.

4. Use the Results Should Be drop-down box to specify the type of files that should be included in the search. You can select or deselect file types such as Clip Art, Movies, and Sounds.

5. When you have finished setting your search parameters, click the Search button. When the search is complete, the clip art that meets your search criteria appears in the task pane.

6. In the Image list, locate the image that you want to place into your Office document. Then, click the image. The application inserts clip art document.

Using the Office Clipboard
Microsoft Office 2003 provides a new version of the Office Clipboard that enables you to accumulate a list of 24 copied or cut items. This makes it very easy to paste items within an Office document, between Office documents in an Office application, or to copy, cut, and paste items among your different Office applications.

To use the Office Clipboard, follow these steps:

1. In an Office application, select Edit and then select Office Clipboard. The Office Clipboard task pane opens.

2. As you cut or copy items from your various Office applications, the items are placed on the Office Clipboard, as shown in Figure 3.6.

3. To paste an item from the Clipboard, place the insertion point in your Office document at the place where you want to insert the item, and then click the item on the Office Clipboard task pane.

You can remove items from the Office Clipboard at any time by placing the mouse on the item. A drop-down arrow appears; click the drop-down arrow and select Delete from the shortcut menu that appears. You can clear the entire Clipboard by clicking the Clear All button at the top of the task pane.
Office Introduction and Shared Features

**Figure 3.6** Use the Office Clipboard to copy, cut, and paste multiple items in your Office applications.
Using the Office Speech Feature

In this lesson, you learn how to train and use the Office Speech feature.

Training the Speech Feature

Microsoft Office 2003 provides you with the ability to enter information into the Office applications using a microphone. You can also enable access to an application’s menu system using voice commands. The Speech feature was first made available with Office XP.

Before you can really take advantage of the Speech feature, you must provide it with some training so that it can more easily recognize your speech patterns and intonation. After the Speech feature is trained, you can effectively use it to dictate text entries or access various application commands without a keyboard or mouse.

The Speech feature is actually installed and then trained in Microsoft Word. So, you must run it for the first time from within Word. After you train the Speech feature in Word, you can then use it in your other applications, such as Excel and PowerPoint. Follow these steps to get the Speech feature up and running:

1. In Microsoft Word, select the Tools menu and select Speech. You will be asked if you want to install the Speech feature; click Yes to continue. After the installation, the Welcome to Office Speech Recognition dialog box appears. To begin the process of setting up your microphone and training the Speech feature, click the Next button.

2. The first screen of the Microphone Wizard that appears asks you to make sure that your microphone and speakers are connected to your computer. If you have a headset microphone, this screen shows you how to adjust the microphone for use. Click Next to continue.

3. The next wizard screen asks you to read a short text passage so that your microphone volume level can be adjusted (see Figure 4.1). When you have finished reading the text, click Next to continue.
Office Introduction and Shared Features

4. On the next screen, you are asked to read another passage. The text is then played back to you. This is to determine whether the microphone is placed at an appropriate distance from your mouth; when you get satisfactory playback, click **Finish**.

When you finish working with the Microphone Wizard, the Voice Training Wizard appears. This wizard collects samples of your speech and, in essence, educates the Speech feature as to how you speak.

To complete the voice training process, follow these steps:

1. The opening Wizard screen provides you with a Sample button that allows you to hear how you should read the text that is supplied during the training session. After reading the directions provided on the opening screen, click **Next** to begin the voice training process.

2. On the next screen, you are asked to begin reading a sample passage (see Figure 4.2). If you need to pause during the process (the initial training takes about 15 minutes), click the **Pause** button.

3. You are asked to read text on several subsequent screens. Words are selected as the wizard recognizes them.

   **Some Words Might Not Be Recognized** If the wizard becomes stuck on a word that it cannot recognize during the training session, click the **Skip Word** button. This skips the current word and allows you to continue the training session.
Chapter 4  Using the Office Speech Feature

Figure 4.2  You read text passages to train the Speech feature.

4. When you complete the training screens, your profile is updated. Click **Finish** on the wizard’s final screen.

You are now ready to use the Speech feature. The next two sections discuss using the Voice Dictation and Voice Command features.

**The Speech Feature Works Better Over Time**  Be advised that the voice feature’s performance improves as you use it. If you pronounce your words carefully and consistently, the Speech feature tunes itself to your speech patterns. You might need to do additional training sessions to fine-tune the Speech feature.

**Using Voice Dictation**

When you are ready to start dictating text into an Office application such as Word, put on your headset microphone or place your standalone microphone in the proper position that you determined when you used the Microphone Wizard. When you’re ready to go, select the **Tools** menu and then select **Speech**. The Language bar appears, as shown in Figure 4.3. If necessary, click the **Dictation** button on the toolbar (if the Dictation button is not already activated or depressed).

After you enable the Dictation button, you can begin dictating your text into the Office document. Figure 4.3 shows text being dictated into a Word document. When you want to put a line break into the text, say “new line.” Punctuation is placed in the document by saying the name of a particular punctuation mark, such as “period” or “comma.”
How Do I Insert the Word “Comma” Rather Than the Punctuation Mark? Because certain keywords, such as “period” or “comma,” are used to insert punctuation during dictation, you must spell these words out if you want to include them in the text. To do this, say “spelling mode,” and then spell out the word, such as c-o-m-m-a. As soon as you dictate an entire word, the spelling mode ends.

When you have finished dictating into the document, click the Microphone button on the Language bar. When you click the Microphone button, the Language bar collapses, hiding the Dictation and the Voice Command buttons. You can also stop Dictation mode by saying “microphone.”

You can minimize the Language bar by clicking the Minimize button on the right end of the bar. This sends the Language bar to the Windows system tray.

With the Language bar minimized in the system tray, you can quickly open it when you need it. Click the Restore icon in the system tray.

Using the Dictation feature correctly requires that you know how to get the Speech feature to place the correct text or characters into an Office document. For more help with the dictation feature, consult the Microsoft Office Help system from any Office application.
Using Voice Commands

Another tool the Speech feature provides is voice commands. You can open and select menus in an application and even navigate dialog boxes using voice commands.

To use voice commands, open the Language bar (click **Tools**, **Speech** or restore the Language Bar from the system tray). Click the **Microphone** icon, if necessary, to expand the Language bar. Then, click the **Voice Command** icon on the bar (or say “voice command”).

To open a particular menu such as the Format menu, say “format.” Then, to open a particular submenu such as Font, say “font.” In the case of these voice commands, the Font dialog box opens.

You can then navigate a particular dialog box using voice commands. In the Font dialog box, for example, to change the size of the font, say “size”; this activates the Size box that controls font size. Then, say the size of the font, such as “14.” You can also activate other font attributes in the dialog box in this manner. Say the name of the area of the dialog box you want to use, and then say the name of the feature you want to turn on or select.

When you have finished working with a particular dialog box, say “OK” (or “Cancel” or “Apply,” as needed) and the dialog box closes and provides you with the features you selected in the dialog box. When you have finished using voice commands, say “microphone,” or click the **Microphone** icon on the Language bar.

Believe it or not, you can also activate buttons on the various toolbars using voice commands. For example, you could turn on bold by saying “bold.” The Bold button on the Formatting toolbar becomes active. To turn bold off, say “bold” again.

A Final Word About the Speech Feature

The Speech feature actually provides a number of possibilities for using voice dictation and voice commands. You will probably want to practice on some documents that aren’t important to your work as you become familiar with the different features provided.

If you find that you aren’t getting very good results with either voice dictation or voice commands, you can do some additional training for the Speech feature. On the Language bar, click the **Tools** icon and then select **Training** from the shortcut menu that appears. The Voice Training Wizard appears (see Figure 4.4). Do the additional training exercises that the wizard supplies.
Office Introduction and Shared Features

**Figure 4.4** Use the Language bar’s Tools button to select the Training feature.
Getting Help in Microsoft Office

In this lesson, you learn how to access and use the Help system in Microsoft Office.

Help: What’s Available?

Microsoft Office supplies a Help system that makes it easy for you to look up information on application commands and features as you work in a particular Office application. Because people have different preferences, the Office Help system can be accessed in several ways. You can

- Ask a question in the Ask a Question box.
- Ask the Office Assistant for help.
- Use the Help task pane.
- Access the Office on Microsoft.com Web site to view Web pages containing help information (if you are connected to the Internet).

Using the Ask a Question Box

The Ask a Question box is the easiest way to quickly get help. An Ask a Question box resides at the top right of every Office application.

For example, if you are working in Excel and would like to get some help with Excel functions (functions are discussed in Lesson 5, “Performing Calculations with Functions,” of the Excel part of this book), type functions into the Ask a Question box. Then press the Enter key. A search will be performed on the Help system and the results of the search (based on your keywords) will appear in the Search Results task pane (see Figure 5.1).

To access one of the Help topics supplied, select the appropriate link in the Search Results task pane. The Help window will appear. In the Help window, you can use the links provided to navigate the Help system. Click on a particular link to read more about that topic. The topic will be expanded in the Help window. When you have finished working with the Help window, click its Close button.
Using the Office Assistant

Another way to get help in an Office Application is to use the Office Assistant. The Office Assistant supplies the same type of access to the Help system as the Ask a Question box. You ask the Office Assistant a question, and it supplies you with a list of possible answers that provide links to various Help topics. The next two sections discuss how to use the Office Assistant.

Turning the Office Assistant On and Off

By default, the Office Assistant is off. To show the Office Assistant in your application window, select the Help menu and then select Show the Office Assistant.

You can also quickly hide the Office Assistant if you no longer want it in your application window. Right-click the Office Assistant and select Hide. If you want to get rid of the Office Assistant completely so that it isn’t activated when you select the Help feature, right-click the Office Assistant and select Options. Clear the Use the Office Assistant check box, and then click OK. You can always get the Office Assistant back by selecting Help, Show Office Assistant.
Asking the Office Assistant a Question
When you click the Office Assistant, a balloon appears above it, as shown in Figure 5.2. Type a question into the text box. Then click the Search button.

Figure 5.2  Ask the Office Assistant a question to get help.

When you click Search, the Search Results task pane appears, containing a list of results. Click a particular topic to open the Help window. Using the Office Assistant actually provides you with the same type of results you receive when you use the Ask a Question box.

Although not everyone likes the Office Assistant because having it enabled means that it is always sitting in your application window, it can be useful at times. For example, when you access particular features in an application, the Office Assistant can automatically provide you with context-sensitive help on that particular feature. If you are brand new to Microsoft Office, you might want to use the Office Assistant to help you learn the various features that the Office applications provide.

TIP  Select Your Own Office Assistant  Several different Office Assistants are available in Microsoft Office. To select your favorite, click the Office Assistant and select the Options button. On the Office Assistant dialog box that appears, select the Gallery tab. Click the Next button repeatedly to see the different Office Assistants that are available. When you locate the assistant you want to use, click OK.
Using the Help Task Pane

You can also forgo either the Type a Question box or the Office Assistant and get your help from the Help task pane; select Help and then the help command for the application you are using, such as Microsoft Word Help. You can also press the F1 key to make the Help task pane appear (see Figure 5.3).

Figure 5.3    Open the Help task pane to search for help by topic.

The Help task pane provides you with the ability to do a search using a keyword or keywords. You can also open the Help table of contents for the application that you are currently working in.

To do a search using the Help task pane, click in the Search box and type a keyword, phrase, or question. Then click the Start Searching arrow. The results of the search will appear in the Search Results task pane. Click a particular result and the Help window will open as shown in Figure 5.4.

To expand any of the help topics provided in the Help window, click a particular link. If you want to expand all the topics provided, click Show All.

TIP    View the Help Window Tabs  If you don’t see the different tabs in the Help window, click the Show button on the Help window toolbar.
Chapter 5  Getting Help in Microsoft Office

Figure 5.4  The Help window provides access to all the help information provided for a particular application.

Searching For Help Online

If you don’t find the help you need using the different ways we discussed in this lesson to access the Help window, you can connect to the Microsoft Office Web site. The site provides a search engine and other information on the different Microsoft Office applications. To connect to the Office Web site, follow these steps:

1. Open the Help task pane (select Help and then your application’s help command, or press F1).
2. In the Help task pane, click the Connect to Office on Microsoft.com link.
3. The Microsoft Office Web site will open in your Web browser window. Use the links to the various articles and the Search engine provided to find the help that you need.

TIP  Take Advantage of ScreenTips  Another Help feature provided by the Office applications is the ScreenTip. All the buttons on the different toolbars provided by your Office applications have a ScreenTip. Other buttons or tools in an Office application window can also provide ScreenTips. Place the mouse on a particular button or icon, and the name of the item (which often helps you determine its function) appears in a ScreenTip.
Customizing Your Office Applications

In this lesson, you learn how to customize your Office applications.

Navigating Options Settings

Office applications provide you with a great deal of control over the desktop environment that you work in. You can control options such as how the application window looks for a particular Office application and where the application should store files, by default, when you save them.

Every one of the Office applications has an Options dialog box that provides access to different settings that you can customize. First, you take a look at how you open and navigate the Options dialog box in an Office application. Then, you look at several of the applications and some of the key options they offer that you might want to customize.

Customizing Office Applications

You might want to work with the Office applications described in this book before you change a lot of options for the applications. A good way for you to do this is to explore the other parts of this book and then return to this lesson when you are ready to customize some of the options in the Office applications you use most.

To open and navigate the Options dialog box in an Office application, follow these steps:

1. In an Office application (such as Word), select **Tools, Options**. The Options dialog box for that application appears (see Figure 6.1).
2. To switch between the different options, click the appropriate tab on the Options dialog box. Each tab controls a subset of the options available in that application.
3. To change settings on the various tabs, use the check boxes, drop-down lists, or spinner boxes to make your selections for various features.
4. When you have finished customizing the various options in the Options dialog box, click **OK**. You are returned to the application window.
The Options dialog box in an application enables you to customize various settings.

You will find that you can set a large number of options in the Options dialog box for each Office application. This doesn’t mean that you have to change them all (if you’re not sure what you’re doing, in many cases you shouldn’t change them). Next, take a look at some of the common settings that you might want to change in your Office applications; you’ll look at Word, Excel, PowerPoint, and Access individually in the sections that follow.

**Customizing Outlook** Because Outlook is customized differently than the other Office applications, see Lesson 20, “Customizing Outlook,” in the Outlook section of this book (Part III).

### Setting Options in Word

When you work in Word, you are probably going to create letters and envelopes for mailings. One of the options related to Word that you will want to set up is your user information. This way, the return address on any letters and envelopes you create with Word are inserted automatically into certain documents.

Another set of options that you might want to customize in Word are the options related to the Spelling and Grammar Checker. For example, you might want to customize the types of things that are automatically flagged by the Spelling and Grammar Checker when you run these features in Word.
To customize some of the Word options, follow these steps:

1. In Word, select **Tools** and then select **Options** to open the Options dialog box.
2. Click the **User Information** tab on the Options dialog box (see Figure 6.2).

![Options dialog box]

**Figure 6.2** Provide your name and address on the User Information tab.

3. If necessary, type your name into the Name box on the User Information tab. Type your address into the Mailing Address box. That takes care of the User Information tab.
4. To set options related to the Spelling and Grammar features, click the **Spelling & Grammar** tab (see Figure 6.3).
5. Check boxes are provided that allow you to check spelling as you type or to hide any typing errors in the document (by default, typing errors are flagged as you type with a red underscore). You can also determine whether you want the Spelling feature to ignore uppercase words, words with numbers, and Internet and file addresses. Select or deselect check boxes as needed.
6. Use the Grammar box on the Spelling & Grammar tab to set options such as Check Grammar As You Type. You can also set whether the grammar in the document is checked whenever you run the Spelling and Grammar Checker (select **Check Grammar with Spelling**).
Chapter 6  Customizing Your Office Applications

Figure 6.3  Set Spelling and Grammar options on the Spelling & Grammar tab.

7. When you have finished setting options on the two Options dialog box tabs discussed in these steps, click OK to close the Options dialog box. If you don’t want any of your changes to take effect, click Cancel.

Setting Options in Excel

When you work with Excel, you work with numbers and calculations. As you learn in the Excel section of this book (Part V), Excel is a number cruncher. It is built to do math and provide you with correct results when it does calculations.

Two of the options that you might want to adjust related to Excel specify when it recalculates all the formulas in an Excel workbook and the rules that it uses to check for errors in an Excel worksheet.

Follow these steps:

1. In Excel, select Tools and then select Options. The Options dialog box opens.

2. Click the Calculation tab on the Options dialog box (see Figure 6.4).

3. When you work with very large worksheets and worksheets that are linked to other Excel workbook files, your worksheet is recalculated every time you change or add data on the worksheet. If you have a computer with marginal
processing power and memory, this process can take a while. You can turn off the automatic recalculation feature on the Calculations tab by clicking the Manual option button. If you do this, you must press F9 to make Excel recalculate the sheet.

![Options dialog box](image)

**Figure 6.4** Set options related to calculations on the Calculation tab.

4. You might want to look at another set of options on the Error Checking tab (click it). This tab contains a list of errors that Excel can automatically check for as you work on your worksheet (see Figure 6.5).

5. To set a default color for errors found in a worksheet, click the Error Indicator Color drop-down box and select a color from the color palette (because the Spelling Checker and smart tags use red, don’t pick red).

6. You should probably leave the error rules listed all in force. However, notice in Figure 6.5 that the Formulas Referring to Empty Cells check box is not selected. This is because you typically enter formulas into worksheets even before data is entered. After creating a worksheet, you might want to select this option, especially if you are working on a large, complex worksheet. This ensures that you get all the data into the appropriate cells, or Excel will start sending error messages your way.

7. When you have finished setting these options, click OK to close the Options dialog box (or Cancel to discard changes).
Setting Options in PowerPoint

After you work in PowerPoint for a while, you might find that you want to specify a view to be the default view when you open presentations that you have created. Another option you might want to set is the default location where presentations that you save are placed.

Follow these steps to change these PowerPoint options:

1. In PowerPoint, select Tools and then select Options to open the Options dialog box.
2. Click the View tab on the Options dialog box (see Figure 6.6).
3. Click the Open All Documents Using This View drop-down list and select a view that you want to use whenever you open a saved presentation. The views range from Normal-Outline, Notes, and Slide to Slide Sorter.
4. Another option you might want to set is the default folder that is used when you first save a presentation. Click the Save tab on the Options dialog box.
5. In the Default File Location box, type the path that you want to use.
6. When you have finished changing your settings, click OK (or Cancel to reject any changes made).

Figure 6.5  Error checking helps make sure that your worksheet data is entered correctly.
Setting Special Options in Access

When you work in Access, you spend a lot of time in the Datasheet view, adding and manipulating records in a database table. Although forms can be used to handle some of the data entry and editing chores (as discussed in the Access section of this book [Part VI]), you still will work a great deal with table datasheets. Therefore, you might want to customize the Datasheet view to make it easier to work with and provide an environment that is a little easier on your eyes.

Follow these steps to customize Access options:

1. In Access, select Tools and then select Options. The Options dialog box opens.
2. Click the Datasheet tab on the Options dialog box (see Figure 6.7).
3. Use the Font drop-down box to select a color for the font used in the Datasheet view.
4. The Background and Gridlines drop-down boxes can be used to adjust the colors of these items to complement the Font color you select.
5. If you want to change the Default Cell Effect, select either the Raised or Sunken option buttons.

Figure 6.6  Set the default view that will be used when you open a saved presentation.
Chapter 6  Customizing Your Office Applications

Figure 6.7  You can edit the datasheet colors and other settings on the Datasheet tab.

6. You can also specify a wider default column width for your datasheets in the Default Column Width box.
7. When you have finished making your changes, click OK (or Cancel to discard any changes made).

Customizing Toolbars

You might find as you use your Office applications that you would like to customize your toolbars. This enables you to add or remove buttons from the toolbars so that they provide you with quick access to the commands and features you use the most often.

For example, suppose you would like to add or remove buttons from a particular toolbar, such as the Formatting toolbar (which is common to a number of Office applications). Follow these steps:

1. In any application (such as Word), place the mouse on a toolbar’s drop-down arrow (on the far right of the toolbar). Click the drop-down arrow to open a shortcut menu.

2. On the toolbar shortcut menu, point at Add or Remove Buttons, and then point at the toolbar’s name on the pop-up menu that appears. A list of all the buttons available for that toolbar appears (see Figure 6.8). The buttons that are being used on the toolbar have a check mark to the left of them.
You can add or remove buttons from a toolbar.

3. Click a button to deselect it (remove it), or click one of the unselected buttons listed to add it.

4. Repeat step 4 until you have customized the buttons shown on the toolbar. Then, click anywhere in the application window to close the Button drop-down list.

**TIP**  **Resetting a Toolbar**  If you want to reset a toolbar and start from scratch with the default buttons, open the Button drop-down list for a particular toolbar and then click **Reset Toolbar** at the very bottom of the Button drop-down list.

Another setting related to toolbars that you might want to adjust is for the Standard and Formatting toolbars in your Office applications, which are set up, by default, to share one line. This limits the number of buttons that can be shown on either of the toolbars at any one time. To place each of these toolbars on its own line, follow these steps:
Chapter 6  Customizing Your Office Applications

1. In any application (such as Word or Excel), select the Tools menu and then select Customize.

2. The Customize dialog box opens. Click the Options tab, if necessary.

3. On the Options tab, click the Show Standard and Formatting Toolbars on Two Rows check box.

4. Click Close.

TIP Get Toolbars in Two Rows Quickly  You can also quickly place the Standard and Formatting toolbars on two rows by clicking the Toolbar Options button on the Standard toolbar (when the toolbars are in a single row) and selecting Show Buttons on Two Rows.
Using Office Web Integration Features

In this lesson, you learn how to use various Web features in your Office applications.

**Adding Hyperlinks to Office Documents**

Microsoft Office provides several features that allow you to integrate features that you typically associate with the World Wide Web into the Office documents that you create. Office documents can be saved in the HTML format and then incorporated into Web pages. Hyperlinks can be placed into Office documents, including Excel workbooks and even Access tables. A *hyperlink* is a text entry or a graphic that, when clicked, opens a Web page on the World Wide Web, a file on your hard disk, or a file on a local network.

Hyperlinks are basically pointers that enable you to quickly access Web content or another file when the hyperlink is clicked. Hyperlinks can also take the form of an e-mail address and can be used to quickly fire off an e-mail message when the link is selected.

Adding a hyperlink to an Office document follows pretty much the same procedure in all the Office applications. In fact, the Insert Hyperlink dialog box is identical in Excel, Word, PowerPoint, Publisher, and Access (you can also add hyperlinks to Outlook e-mails in a Insert Hyperlink dialog box that requires you to type the hyperlink address).

Next, take a look at adding a hyperlink to an Excel worksheet. To add a hyperlink, follow these steps:

1. Select the text or graphic you want to use for the hyperlink (in Excel, select a cell; in Access, click in a Table field).
2. Select the Insert menu and then select Hyperlink. The Insert Hyperlink dialog box appears, as shown in Figure 7.1.
3. Type the address of the Web page to be used by the hyperlink into the Address box at the bottom of the dialog box.
4. If you would like to select the address of the Web page from a list of Web sites that you have recently browsed with Internet Explorer, click the Browsed Pages button in the dialog box. Click a link in the list that appears. It will be placed into the Address box.

5. If the link is to an e-mail address rather than to a Web page or file on your computer, click the E-Mail Address icon on the left of the dialog box.

6. A list of recently used e-mail addresses that you can select from appears in the dialog box, or you can type the e-mail address into the E-Mail Address box, as shown in Figure 7.2.

7. To display a ScreenTip when the mouse pointer rests on the hyperlink, click the ScreenTip button; in the dialog box that appears, enter the description you want to display. Click OK.
8. Click OK to close the Insert Hyperlink dialog box. The text or graphic that was selected becomes a hyperlink. Text hyperlinks appear in a blue font and are underlined.

Figure 7.3 shows a text hyperlink that has been added to an Excel worksheet on the words “Link to First Quarter Summary Web page.” The link could be used to quickly access a Web page that has information related to the worksheet shown in the figure.

![Excel worksheet with hyperlink](image)

**Figure 7.3** Hyperlinks provide quick access to Web pages and files.

When you move the mouse pointer over this link, it changes to a hand. Next to the hand, you can see the address of the link. Click the link and you jump to the appropriate worksheet, Web page, file, or e-mail program. The text color of the link changes to purple to indicate that you have used the link.

**TIP**  
**Creating Hyperlinks to Documents on Your Computer**  
To insert a hyperlink for a document on your computer, use the Look In box in the Insert Hyperlink dialog box to find the drive that the file resides on, and then open the appropriate folder to locate the file. Select the file in the dialog box to create the link.
Chapter 7 Using Office Web Integration Features

Saving Office Documents As Web Pages

You can save any of your Office documents, such as Word documents, Excel worksheets, and PowerPoint presentations as HTML documents (you can also convert Publisher publications to the HTML format using the Publish to the Web command on the File menu). After you save an Office document in the HTML format, you can view the document in the Internet Explorer Web browser.

HTML  Short for Hypertext Markup Language, HTML is the language in which data is presented on the World Wide Web. Office uses the term “Web Page” to define the format type in which you save an Office document for the Web. You are actually converting the document to HTML format.

Saving Office documents as Web pages is similar regardless of whether you are using Word, Excel, or PowerPoint. The Save As Web Page command on the File menu is used to save an Office document in the HTML format. Access is the exception, however: Access objects, such as tables, can be made into Web pages using the Export command on the Access File menu.

Before you save a Word document, Excel worksheet, or a PowerPoint presentation as a Web page, you might want to preview the document as it would appear in a Web browser. For example, suppose you have a PowerPoint presentation and you would like to see how it would look on the Web.

Select the File menu and then select Web Page Preview. It might take a moment as your file is prepared; when it’s ready, Internet Explorer opens and your Office document appears in the browser window. Figure 7.4 shows a PowerPoint presentation in the Internet Explorer window. Notice that links to all the slides in the presentation have been automatically created for the Web version of the presentation.

After you preview your Office document as a Web page, if things look good, you can quickly save it as a Web page in the HTML format. Next, take a look at saving a PowerPoint presentation as a Web page to get the overall feel for converting any Office document to the HTML format (the procedure is similar in Word and Excel).

Follow these steps:

1. Choose the File menu and then choose Save As Web Page. The Save As dialog box appears (see Figure 7.5).
2. In the File Name text box, enter a filename for the Web page document or go with the default name provided (it will be the current name of the file). Notice that in the Save As Type box, the file type is Web Page.
Office Introduction and Shared Features

Figure 7.4 You can preview an Office document as a Web page.

Figure 7.5 Office documents can be saved as Web pages.

3. If you want to change the page title for the presentation, click the Change Title button. Type a new title and then click OK.

4. Click Save. Your Office document (in this case, a presentation) is saved.

TIP PowerPoint Enables You to Select the Slides for the Web Page In the case of PowerPoint, you can select the slides in the presentation that you actually want to include in the Web page document that you are creating. Click the Publish button and select the slides you want to include in the HTML document. You can
also specify in the Publish dialog box which Web browsers (such as Internet Explorer or Netscape Navigator) the PowerPoint Web page should support.

When you save an Office document, such as a Word document or PowerPoint presentation, as a Web page, you have the choice of saving the file as a single file Web page (where all the pictures and other items are made part of that file), or you can save the file as a “typical” Web page that actually creates several files. Any graphics, objects, or other special elements in the document are saved as separate files in the appropriate format for the Web.

For example, in the case of PowerPoint, if the presentation file named Broadway.ppt is saved as a Web page (not as a single file Webpage), the home page would be named Broadway.htm. Then, PowerPoint creates a folder named Presentation Name Files (for example, Broadway Files) that contains all the other HTML, graphics, and other files needed to display the complete presentation. If you are transferring the HTML presentation to another PC (which is very likely, if you are going to make it available on the World Wide Web), you must transfer not only the lone HTML home page, but also the entire associated folder.

**Adding an FTP Site to Your Save In Box**

After you save an Office document as a Web page or create a Web page using Microsoft Word or Publisher, you may need to load that file onto a Web server. You can save the Web pages that you create in the Office applications directly to a Web server that also functions as an FTP site.

**FTP** FTP (File Transfer Protocol) is a protocol that allows you to download and upload files to an FTP server. An FTP server is a computer connected to the Internet that hosts an FTP site and provides space for file transfers (this includes file uploads and downloads).

You can save your Web files to an FTP site on the Internet (or a company intranet), provided you have the permission to do so. The first step is to add the FTP site to the Save As dialog box:

1. Open the Save In list and select Add/Modify FTP Locations. The Add/Modify FTP Locations dialog box appears, as shown in Figure 7.6.
2. In the Name of FTP Site text box, enter the site’s address, such as ftp.microsoft.com.
3. Select Log On As, either Anonymous or User, and enter a password, if necessary.
Figure 7.6  Saving to an FTP site can get files onto the Web or a company’s intranet.

4. Click OK.
5. After the site has been added to the Save As dialog box, you can select it from the FTP Locations folder in the Save In list.
Faxing and E-Mailing in Office 2003

In this lesson, you learn how to fax and e-mail documents from Office applications.

Understanding E-Mails and Faxes in Office

The capability to send e-mail and faxes directly from your Office applications enables you to quickly take the information on your screen and either fax it or e-mail it to a recipient. When you send an e-mail message directly from an Office application client, such as Word, Excel, Access, or PowerPoint, you are actually using your default e-mail client, such as Outlook, to send the message.

All the Office applications allow you to send the current document as an attachment. Word and Excel also provide the option of sending the document as part of the e-mail message.

There are two options for faxing documents from within an Office application. You can either send the fax using an Internet Fax Service, which allows you to actually fax the document over the Internet, or you can outfit your computer with a fax modem. Fax modems actually supply faxing capabilities as an extension of your computer’s printing services.

TIP Sign Up for an Internet Fax Service If you want to fax documents over the Internet, you need to sign up for an Internet Fax Service. Several Internet Fax Services exist, which not only allow you to fax information over the Internet but may also enable you to receive faxes over the Internet and have them sent to you as e-mail messages. The first time you attempt to use the Internet Fax Service to send a fax from a Microsoft Application, you are provided with the option of navigating to a Web page that lists Internet Fax Providers. The cost related to these services will vary.

Word makes the process of sending a fax easy and provides a Fax Wizard to walk you through the steps. The other Office applications send faxes in two different ways: either by “printing” to a fax modem or by using the Send To command on the File menu to send an Internet fax (Word also provides this option). Sending a fax from the Office applications via a fax modem is discussed later in the lesson.
To send a fax from any Office application using an Internet Fax Service, you click File, and then point at Send To. On the menu that appears, select Recipient Using Internet Fax Service. You can then complete the process by providing the recipient’s fax number and other information required for a fax cover page.

Internet Fax Services provide their own cover page and set of instructions for sending a fax. The actual number of steps that you have to complete to send an Office document as a fax over the Internet depends on the actual service that you use.

**Using the Word Fax Wizard**

The Word Fax Wizard walks you through the steps of preparing your Word document. You can send your fax using a fax modem (attached to your computer) or using an Internet Fax Service.

**Setting Up a Fax Modem and the Fax Service**

Most “new” fax modems embrace plug-and-play technology as do Microsoft Windows XP and Microsoft Windows 2000. In most cases all you will have to do to get a fax modem up and running is to attach the modem to the computer (or install it internally) and then restart the PC. Windows XP requires that you add the Microsoft Fax Service to your computer to send and receive faxes. You add this service in the Printers and Faxes window of the Control Panel. When you open this window, click the Install Faxing link on the left side of the window and follow the prompts. Make sure you have your Windows XP CD available because files need to be copied to your system to enable the fax service.

To use the Word Fax Wizard and send a fax using a fax modem (in the Windows XP environment), follow these steps:

1. Select File, point to Send To, and then select Recipient Using a Fax Modem from the cascading menu. The Word Fax Wizard starts (see Figure 8.1).
2. The Fax Wizard starts to walk you through the process of sending the current document as a fax. Click Next to continue the process.
3. On the next wizard screen, a drop-down list enables you to select whether to send the current document or select another open document (see Figure 8.2). After making your selection, click Next to continue.
4. On the next screen, you select your fax service. Microsoft Fax is the default. If you use a different fax program on your computer, select the option button labeled A Different Fax Program Which Is Installed on This System, and then select your fax program from the Fax Service drop-down list. Then click Next to continue.
Figure 8.1  The Fax Wizard walks you through the process of sending the current document as a fax.

Figure 8.2  You can select whether to send the current document or select another open document.

5. At this point the Fax Wizard has completed the initial process of selecting the document and fax service. When you click Finish, the Send Fax Wizard appears. Click Next to bypass the initial Wizard screen.

6. On the next screen (see Figure 8.3), enter the recipient and the fax number into the appropriate boxes. If you have the recipient listed in your e-mail program’s address book (such as the Outlook Contacts folder), click the Address Book button and select the person from the Address Book list. If a fax number is listed in the address book (as it is in Microsoft Outlook), all you have to do is select the recipients from the address book for your Word fax, and the fax numbers are entered for you automatically. When you have finished entering the recipient information for the fax, click Next to continue.
7. On this screen, select the cover page template you want to use for your fax cover page. Also provide a subject line and note (optional); click Next to continue.

8. On the next screen, you choose the schedule for when the fax should be sent. The default is Now, but you can also select a specific time. This screen also allows you to specify the priority for the fax: High, Normal (the default), or Low.

9. On the final screen of the Fax Wizard, you are can choose to preview the fax. Click the Preview Fax button to see the fax cover page and accompanying document. When you are ready to send the fax, click Finish.

Your fax modem will connect to your phone line and send the fax (if you chose to send the fax “Now”). If you want to view sent faxes or view a list of faxes waiting to be sent by the Microsoft Fax Service, you can open the Fax Console. Select Start, All Programs, Accessories, Fax, and then click on the Fax Console. The Fax Console operates much like an e-mail client. It provides an Inbox, Outbox, and Sent Items folders that store your received, pending, and sent faxes respectively.

**Sending Faxes from Other Office Applications**

You can also send faxes directly from other Office applications. You “print” the document to the fax service installed on your computer.

Follow these steps to send a fax from an Office application such as Excel or Access:

1. Select File and then select Print to open the Print dialog box.
2. In the Name box in the Print dialog box, select the fax service that you have installed on your computer (see Figure 8.4).
Figure 8.4  Select your fax service as the printer in the Print dialog box.

3. Click OK. Depending on the fax service you are using on your computer, a dialog box or wizard specific to the fax service opens. For example, if you have the Windows fax service installed on your computer, the Send Fax Wizard opens. You would then click Next to advance past the opening screen provided by the wizard.

4. Follow steps 5 through 8 in the preceding section if you are using the Windows Fax Service. At the completion of the process, click Finish to send your fax.

Sending E-Mails from Office Applications

If you have an e-mail client (software for sending and receiving e-mail) on your computer, such as Microsoft Outlook, you can send Office documents in e-mails. You can send a Word document, an Excel worksheet, or even an entire PowerPoint presentation with an e-mail message.

E-Mail Client  The e-mail program installed on your computer that you use to send and receive e-mail.

The process for sending e-mail from the different Office applications is the same for Word, Excel, PowerPoint, and Access. You use the Send To command on the File menu.

You can send Word or Excel files embedded in the e-mail message or you can send them as attachments. In the case of PowerPoint and Access, the file you currently have open can only be sent with the e-mail message as an attachment.
In most cases, sending the file as an attachment makes it easier for the recipient to manipulate the file after they receive it. To send an Excel worksheet as an attachment, follow these steps:

1. Select **File** and then point at **Send To**. Select **Mail Recipient (as Attachment)** from the cascading menu that appears. A new e-mail message opens (in your default e-mail client, such as Outlook) with the Excel file attached (see Figure 8.5).

![Figure 8.5](image)

**Figure 8.5** The new e-mail message contains the Excel file as an attachment.

2. Type the e-mail address of the recipient into the To box, or click the To icon and select an e-mail address from an address book, such as your Outlook Contacts list.

3. When you are ready to send the e-mail, click **Send**.

Your e-mail is sent. You can view the sent e-mail by opening your e-mail client and then opening the Sent Items folder.
Sending Word and Excel Files Using the Mail Recipient Command

As already mentioned, Word and Excel can send documents as the body of an e-mail. When you select **File, Send To** and then **Mail Recipient**, a mail window actually opens at the top of the Word or Excel document. You enter the recipient and other information required and then click the **Send This Sheet** button (in Excel) or **Send a Copy** button (in Word) that is provided on the Mail toolbar. For recipients to view this e-mail correctly they will need to be using Outlook. If they use another type of e-mail client, you are better off sending the file as an attachment.

One thing to remember when you are e-mailing documents directly from Office applications is that you must be connected to the Internet or your company’s network to actually send the mail. If you use a dial-up connection to access the Internet (and Internet e-mail), connect to the Internet before sending the e-mail from the Office application.
Upgrading to Outlook 2003

In this lesson you learn what’s new in Outlook 2003.

What’s New in Outlook 2003?

Outlook 2003 is the latest version of Microsoft’s popular personal information manager (PIM). Outlook 2003 has a new look and a number of new features. Outlook 2003 is further enhanced by the addition of the Business Contact Manager, which is an add-on to Outlook that provides you with the ability to organize and track business activities.

A number of enhancements have been made to Outlook 2003. Some of these changes are as follows:

- **New Navigation Pane**—The new Navigation pane provides icons that allow you to navigate the major areas of Outlook such as the Mail, Calendar, and Contacts. Subpanes are also provided that make it easier to access data in a particular Outlook tool; for example, the All Mail Folders pane appears when you select Mail on the Navigation pane. (These subpanes are also referred to as panes).

- **New Reading Pane**—The preview pane found in previous versions has been upgraded to the new Reading pane, which provides a vertical orientation for reading e-mail messages.

- **Junk E-mail Filter**—A junk e-mail filter has been added to Outlook and helps to rid your Inbox of useless junk e-mail. For more protection against unwanted e-mail, you can design your own e-mail rules as in previous versions of Outlook.

- **Research Task Pane**—The new Research task pane is available in Outlook (and the other Office applications) and can be used to look up stock, financial, and other information from a variety of online resources.

1 TIP **Business Contact Manager Lessons** The Business Contact Manager is covered in Lessons 21 and 22 of the Outlook section (Part III) of this book.
• **Business Contact Manager**—The biggest change to Outlook is the addition of the Business Contact Manager. It provides a repository for entering and tracking business contacts, accounts, and opportunities.

• **Search Folders**—Search Folders allow you to set up search criteria for e-mail messages. The messages that match the search criteria are then listed in the specific Search Folder. This provides a great way to see lists of messages that are grouped by different criteria. Search Folders are discussed in this lesson. Lesson 18, “Saving and Finding Outlook Items,” in the Outlook section of this book (Part III) also discusses Search Folders and their relationship to the Find and Advanced Search features.

• **Favorite Folders Pane**—This pane is available when you select Mail on the Navigation pane (it is only available in the Mail view). It allows you quick access to any mail folders in Outlook. By default, the Inbox and Sent Items folders are included in the Favorite Folders pane. To add other mail folders to the pane, such as those you create, right-click a folder containing mail and select **Add to Favorite Folders** on the shortcut menu that appears.

We take a quick look at some of these listed new features and other new features in the remainder of this lesson. For more details related to working in Outlook, see Part III of this book.

**Using the New Navigation Pane**

The new Outlook Navigation pane makes it easier to access the different tools in Outlook such as the Mail, Contacts, Calendar, and Tasks features. Each Outlook tool has its own button on the Navigation pane. To access a particular tool, such as Mail, click the appropriate icon on the Navigation pane.

The Navigation pane provides additional navigational features that make it an improvement over the Outlook bar that was used for navigation in previous versions of Outlook. For example, when you click the Mail icon on the Navigation pane, the Favorite Folders and All Mail Folders subpanes appear on the Navigation pane as shown in Figure 1.1.

The Favorite Folders pane makes it easy for you to access unread mail and messages that you have sent. The All Mail Folders pane provides access to other e-mail accounts that you have configured in Outlook (such as a Hotmail account) and also provides access to Outlook archived files.
Not only does the Navigation pane make it easier to access your e-mails, but it also makes it easier to access information in any of the Outlook tools such as the Calendar and Contacts. Figure 1.2 shows the Navigation pane after Contacts has been selected. It provides you with access to the different types of contacts stored in Outlook and also provides different views for viewing your contacts.

**TIP**

**Outlook Section Provides Overview of Using Outlook** For more about working in Outlook and sending e-mail, creating contacts, and working with the calendar, see Part III of this book.
Creating Search Folders

Another new feature provided by Outlook is the Search Folder. A Search Folder is a way to logically group information such as mail or contacts and then view the information. A Search Folder that you create is really a virtual folder; it doesn’t actually exist as the mail or contacts folders exist, but it groups information such as mail, contacts, or appointments according to your search criteria. Because Search Folders can be saved (you are actually saving the search criteria that make the Search Folder), they can be used to quickly view data in Outlook whenever needed.

To create a search folder for e-mail messages, follow these steps:

1. Select the File menu, point at New, and then select Search Folder. The New Search Folder dialog box opens (see Figure 1.3).
2. Select the type of Search Folder that you will create from the New Search Folder dialog box such as Mail from Specific People or Mail with Attachments.
3. After selecting the type of search folder, you have to supply additional information. For example, in the case of a Mail from Specific People search folder, you have to specify the e-mail senders that will be used to logically group the mail in the search folder. To see a list of people in your Contacts or other list, click the Choose button at the bottom of the New Search Folder dialog box.
Chapter 1  Upgrading to Outlook 2003

Figure 1.3  Logically group Outlook information in search folders.

4. The Select Names dialog box will open. You can use the drop-down list on the right of the dialog box to view your Contacts folder or other list (such as the Business Contacts folder). Select the name or names to use for the search folder. Then click the **From** button.

5. When you have completed adding the names the search folder will use, click **OK**. You will be returned to the New Search Folder dialog box. Click **OK** to create the new folder.

The new search folder appears in the Outlook window and lists the items such as mail that meet the criteria that you specified for the folder. Search folders that you create can be accessed by opening your personal folders in the All Mail Folders pane and then opening the Search Folders icon. This will list all search folders available in Outlook.

**TIP  Search Folders Exist by Default** Some search folders are available in Outlook by default. For example, the Mail search folders provided are the Unread Mail and For Follow Up folders found in the All Mail Folders pane.

**Introducing the Business Contact Manager**

An important change to Outlook is the addition of the Business Contact Manager (BCM). The BCM allows you to manage business contacts, business accounts, and business opportunities in the familiar Outlook environment. The BCM is an add-on program and adds a Business Tools menu to the Outlook menu bar (see Figure 1.4).
The BCM data such as Business Contacts and Accounts are accessed via the Contacts button on the Navigation pane. Your business opportunities are accessed via the Tasks button on the Navigation pane. For more about the Business Contact Manager, see Lessons 21 and 22 in the Outlook section (Part III) of this book.

### Importing E-Mail Accounts and Other Data

For those of you who have used other e-mail clients in the past and are just now upgrading to Outlook as your e-mail software, you may want to import your e-mail settings and even your mail messages from another e-mail software package that is installed on your computer. Outlook can import e-mail accounts, messages, and other data such as contacts. Outlook can import e-mail accounts and messages from Outlook Express and Eudora.

TIP **Settings from Previous Versions of Outlook Used by Outlook 2003**

When you upgrade a previous version of Outlook to Outlook 2003, settings, accounts, and preferences that you made in the previous version of Outlook are used in Outlook 2003.

Data can also be imported from other programs used to manage calendars and contacts such as Act! and Lotus Organizer. Let’s take a look at the steps used to import e-mail settings into Outlook 2003.

1. Select the File menu, point at **Import and Export**, and then select **Standard**. The Import and Export Wizard will appear.
2. On the Import and Export Wizard screen, select **Import Internet E-mail Account Settings** and then select **Next**.
3. The next wizard screen (which starts the Internet Connection Wizard) provides a list of e-mail clients that you have installed on your computer (see Figure 1.5). Select the e-mail client that contains the settings. Click **Next** to continue.
Chapter 1  Upgrading to Outlook 2003

Figure 1.5  You can import settings from other e-mail clients.

4. The next screen asks you to provide the name that you want to appear in the From box when you send e-mail. Type the name (or go with the default, which is imported from the other e-mail client) and then click Next to continue.

5. Your e-mail account will appear on the next screen (as it was set up for the e-mail client). Click Next to continue.

6. On the next screen the e-mail servers for the account will appear (the POP and SMTP servers). Click Next to continue.

7. On the next screen, the account name you used for e-mail will appear. You also have to enter your e-mail password. Click Next.

8. The next screen shows the connection type that you use to connect to the Internet such as a phone line or a LAN connection. Check to make sure these settings are correct and then click Next.

9. The final screen will appear, letting you know that all the information needed has been collected. Click Finish.

The imported e-mail account settings will be added to Outlook. If you also want to import mail messages or contacts from the other e-mail client, run the Import and Export Wizard again and make the appropriate choices.
Upgrading to Word 2003

In this lesson, you learn what’s new in Word 2003.

What’s New in Word 2003?

Microsoft Word 2003 offers a number of new features that make it an even more efficient and easy-to-use word processor and desktop publishing environment than its predecessors. These new features range from the new shared Document Workspace to the new Reading Layout view to the new Research task pane. Some of the new Word features that you will explore in this book are as follows:

- **Document Workspace**—Using a SharePoint server, you can create an online workspace that allows users at different sites to view and edit the same Word document. The Document Workspace is discussed in Lesson 1 in Part I of this book.

- **Research Task Pane**—The Research task pane allows you to access online resources that range from business Websites, to stock information, to online encyclopedias such as Microsoft’s Expedia. Figure 2.1 shows the Research task pane in the Word workspace. The Research task pane is discussed in more detail in Lesson 4, “Using Proofreading and Research Tools,” in the Word section of the book (Part IV).

- **Reading Layout View**—The Reading Layout view allows you to view a document as it will print and also edit the document as you read it. The Reading Layout view is discussed briefly in Lesson 8, “Examining Your Documents in Different Views,” of the Word section of this book.

- **Compare Side by Side With**—This new command found on the Window menu allows you to compare documents side by side on the Windows desktop.

Word 2003 also offers other enhancements. These include the ability to create XML documents (discussed later in the lesson), Tablet PC support, and better integration with the Office Online Web site.
Figure 2.1  The Research task pane makes it easy for you to quickly look up information in a variety of online reference tools.

Understanding File Format Issues

Word 2003 saves Word documents by default in the Word file format that is also embraced by Word 2000 and Word 2002. If you plan to use an earlier version of Word (such as Word 6.0) on another computer or will share Word documents with users who still use an earlier version of Word, you will need to save your documents in the appropriate file format.

The easiest way to manage file formats in Word is to save all documents in the Word file format and then use the Save As command to save documents in a format that will be used by collaborators who use an earlier version of the Word software.

To save a document in a file format compatible with earlier versions of Word, follow these steps:

1. Open the document that you want to save in a different file format (File, Open).

2. Select File, then Save As to open the Save As dialog box as shown in Figure 2.2.
3. Click the **Save as Type** drop-down box in the Save As dialog box and select the Word 97-2002&6.0/95-RTF file format. This file format is compatible with any version of Word from Word 95 to Word 2003.

4. Type a new filename for the document (if necessary).

5. Click **Save** to save the document in the new file format.

### Word and XML Documents

XML or eXtensible Markup Language is a markup language that allows you to tag the contents of a document; the tags not only define the tagged contents of the document (as HTML codes do) but also allow for the validation and transmission of data in the document. Although XML is beyond the scope of this book, the ability for a user to create XML documents directly in Word is an important advance to the Word environment (as was the addition of Web site creation tools to earlier versions of Word).

Not only does Word provide a platform for the creation of XML documents, but it also provides for user-defined schemas for the XML codes. A schema defines what the actual XML codes do in the document when the XML code is read (by an application that is versed in XML such as a Web browser like Internet Explorer).
Task Panes and Smart Tags

For those of you upgrading from a version of Word prior to Word 2002 (such as Word 2000), the biggest changes in the Word workspace will be the various task panes and smart tags. Task panes have replaced a number of dialog boxes that were used to configure or use certain features. For example, Word styles are now created and modified using the Styles and Formatting task pane as shown in Figure 2.3.

Figure 2.3  Task panes have replaced many Word dialog boxes.

A number of new task panes have been added to Word 2003 including the following: Getting Started task pane, Help task pane, Search Results task pane, Shared Workspace task pane, and Research task pane. Many of these task panes are discussed in the Word section of this book.

A smart tag is a special shortcut menu that provides you with additional options related to a particular feature. Word 2003 has a number of smart tags including paste smart tags and AutoCorrect smart tags.

For example, when you cut or copy information from a Word document and then paste it to a new location, you will find that a paste smart tag appears at the bottom of the pasted item. This enables you to access options related to your paste job, such as whether the information pasted should maintain its original formatting or be formatted the same as text or numbers that are in the same part of the document where you pasted the new information.
Figure 2.4 shows the Person Name smart tag. This smart tag flags proper names and provides you with the option of pulling information about the person (such as their address) from your Outlook Contacts.

**Figure 2.4** Smart tags flag certain text elements in a document.
Upgrading to Excel 2003

In this lesson, you learn what’s new in Excel 2003.

Introducing Excel 2002

Excel 2003 is a powerful spreadsheet program that can help you create worksheets and invoices and do both simple and sophisticated number crunching; it is designed to help you calculate the results of formulas and analyze numerical data. Excel 2003 provides a number of enhancements over previous versions of Excel. Some of these enhancements are as follows:

• **Designate a Range as a List**—Excel allows you to designate a range of cells as a list. You can then manipulate the list using list menus provided at the heading row of the list. You can quickly sort or filter data in the list.

• **Statistical Functions Improved**—Although you won’t necessarily “see” the enhancements that have been made to the statistical functions in Excel such as standard deviation and the forecast function, a number of Excel’s statistical functions have been made to compute and round more accurately.

• **Document Workspaces**—Document workspaces can be created on a SharePoint server that is accessible from the Web. This allows different users to collaborate on Excel workbooks that are stored in the workspace.

• **Compare Side by Side With**—A new command on the Windows menu allows you to compare two worksheets side by side in the Excel window. This makes it easy to view changes that have been made to a worksheet where other users have made changes to the original worksheet.

• **Research Task Pane**—As with the other applications in Office 2003, Excel has access to the Research task pane, which can be used to find financial and other information stored on the Web.

Excel 2003 has had the latest makeover from the previous version of Excel when compared to the other members of the newest version of Office (such as Outlook and Access). We take a broad look at a number of Excel features in Part V of this book. In the balance of this lesson we will look at two new features found in Excel 2003, creating a list from a worksheet range and comparing worksheets side by side.
Creating Worksheet Lists

For users upgrading from versions of Excel prior to Excel 2002, the biggest changes to the Excel environment will be the introduction of task panes. Users upgrading from Excel 2002 to Excel 2003 will find that many changes made to Excel are quite subtle such as the list feature. Most Excel users are familiar with worksheet ranges, a grouping of contiguous cells. You can now specify data in a row or a column as a list and then manipulate the data. This means that even data already in a range can be manipulated as a list.

Creating a list is very straightforward; just follow these steps:

1. Select the range of cells that you want to include in the list. This can be data or other information in several rows or columns.
2. To create the list, select Data, point at List, and then select Create List.
3. The Create List dialog box opens showing the range of selected cells that will be included in the list. Click OK to create the list.

The list will be marked in the worksheet by a yellow frame as shown in Figure 3.1. Notice that drop-down arrows also appear at the top of each column in the list, which can be used to quickly manipulate the data in the list. For example, you can quickly filter the data in the list by selecting a salesperson’s name from the drop-down list that appears.

When you create a list in a worksheet, the List and XML toolbar will appear in the Excel workspace. You can use the toolbar to add a Total row to your data list and then choose from several different formulas by clicking in the Total row.

Remove a Worksheet List  Lists provide a fast way to manipulate a selected range of data that may be part of a larger data set. When you have finished working with a list, you can remove it by right-clicking on the list and pointing at List on the menu that appears. Select Convert to Range and then select Yes to complete the conversion.
Figure 3.1  Lists can be created using ranges in a worksheet.

Comparing Worksheets Side by Side

Excel 2003 makes it easy for users to collaborate on Excel workbooks. For example, the Document Workspace feature allows users to access an Excel workbook on the Web. You may find that you need to compare an original worksheet with an updated or edited version of the worksheet. This can be done in the Excel window by comparing the two sheets side by side.

Follow these steps:

1. Open the workbooks that contain the sheets that you want to compare.
2. From one of the worksheets that you want to compare, select Window, then Compare Side By Side (followed by the workbook’s name). The second workbook will appear in the Excel window (see Figure 3.2).
3. By default, scrolling is synchronized between the two windows. Scroll in either worksheet to scroll in both.
4. When you have finished comparing the worksheets, click the Close Side By Side button on the Compare Side by Side toolbar.
Figure 3.2  Compare worksheets in the Excel window.

You will also work with other Excel enhancements as you work through the lessons in Part V of this book.
Upgrading to Access 2003

In this lesson, you learn what’s new in Access 2003.

What’s New in Access 2003?

Access 2003 is similar in look and feel to its recent predecessors, Access 2002 and 2000; for those of you upgrading from Access 2000, task panes will be new. Data is held in tables and can be directly entered into a table or by using a form. Data tables can then be related, which allows for the filtering and sorting of data using queries and reports.

Although Access 2003 does not sport a major makeover as some of the other Office 2003 applications do (such as Outlook 2003), improvements and enhancements have been added to this latest version of Access. Some of the enhancements to Access 2003 are as follows:

- **Error Checking in Forms and Reports** — You can check controls in reports and forms using the new Error Checking feature. This feature is used in the form or report Design view and is discussed in more detail later in this lesson.

- **Back Up and Restore Databases** — Access 2003 makes it easy for you to back up a database file. This allows you to protect your valuable data. You can then restore the database if necessary. Backing up and restoring a database is discussed in more detail later in this lesson.

- **AutoCorrect Options** — Because database text entries are often peculiar unto themselves, you may not always want the AutoCorrect feature to correct certain text entries. An AutoCorrect Option button now appears next to text that is corrected by AutoCorrect, allowing you to quickly undo the correction.

- **SharePoint Server Compatibility** — Other Office 2003 applications such as Word and Excel provide the Document Workspace feature, which allows you to store and share files on the Web using a Microsoft SharePoint server. Access also provides the ability to store tables on a SharePoint server and link to data lists on the Web.

Access File Format Issues

The file format that you select as the default file format will determine whether your Access databases can be opened in previous versions of the Access software. This is important if you are going to share Access files with users who use previous versions of Access (such as Access 2000) or if you are going to also use a computer that is running an earlier version of Access.

To set the default file format for Access databases, follow these steps:

1. In the Access window, select Tools, then Options. The Options dialog box will open.

2. Select the Advanced tab on the Options dialog box (see Figure 4.1).

![Options dialog box](image)

**Figure 4.1** Set the default file format for your Access databases.

3. On the Advanced tab, click the Default File Format drop-down list. The default file format is Access 2000, which provides a file format that is compatible with Access 2000, 2002, and 2003. If you will not be using Access 2000 to work on the database, you may change the file format to Access 2002-2003 (which is compatible with both Access 2002 and 2003).

4. After making your selection, click OK. You will be returned to the Access window.
Access Error Checking

Another new feature provided by Access 2003 is the form and report control error-checking feature. This feature allows controls on forms and reports to automatically be checked for errors. Creating and modifying forms in Access is discussed in the Access portion of this book (Part VI) in Lessons 10, 11, and 12; creating and modifying reports is discussed in Lessons 17 and 18.

The form and report error-checking feature is controlled via the Error Checking tab on the Options dialog box. To view the Error Checking properties, follow these steps:

1. In the Access window, select Tools, then Options. The Options dialog box will open.

2. Select the Error Checking tab on the Options dialog box (see Figure 4.2).

3. You can turn error checking off (it is on by default), by clearing the Enable Error Checking check box. You can also determine the rules that error checking uses on forms and reports. Clear the appropriate rule check box to disable a rule.

4. When you have finished viewing the Error Checking properties, click OK to close the Options dialog box.

Figure 4.2 The form and report error-checking feature.
When you create a form or report in the Design view, labels and controls are created and associated with fields in the tables that make up the database or with formulas that provide summary information. One of the error-checking rules provided by the Error Checking feature is to find labels that are not associated with controls (which are typically associated with a field in a table).

Figure 4.3 shows a label that is not associated with a control. Notice that an error icon has been placed on the label by the Error Checking feature. You can correct the error by clicking on the error icon and selecting a remedy from the list. For example, you can associate the new label with an existing control (a control already on the form) by clicking the **Associate Label with a Control** menu choice. This opens a list of controls on the form so that you can select the associated control. Other possibilities include **Help on this Error**, which opens the Help system and provides you with help on the problem, and **Ignore Error**, which removes the error icon.

![Figure 4.3](image)

**Figure 4.3** The Error Checking feature helps spot errors in forms and reports.

The new Error Checking feature provides you with help in minimizing label and control errors in forms and reports. See the Access section (Part VI) of this book for more about forms and reports.
Backing Up an Access Database

Another new feature that Access 2003 provides is the ability to back up and restore database files. This provides added protection for your valuable data. When you back up the database, it is actually saved in the default database file format (not a compressed or special) backup format. This makes it very easy for you to open a backup database at a later date because it really is just a copy of the original database file.

When you create a database backup, the database file created is timestamped. This allows you to easily differentiate the backups that you create for a database because they will all be date-specific.

To create a database backup, follow these steps:

1. With the database that you want to back up open in the Access window, click File, then Back Up Database. The Save Backup As dialog box will open (see Figure 4.4).

![Figure 4.4](Figure 4.4.png)

Figure 4.4 Back up an Access database file.

2. Supply the location to save the backup in using the Save In drop-down list. The new filename for the backup will be the original filename including the current date (see Figure 4.4).

3. Click Save to save the backup database file.

Backup databases can be opened as any database file can be opened. For more about saving and opening database files, see Lesson 2, “Creating a New Database,” in Part VI of this book.
Upgrading to PowerPoint 2003

In this lesson, you learn what's new in PowerPoint 2003.

What’s New in PowerPoint 2003?

PowerPoint 2003 provides the powerful slide creation and organization tools that are available in its predecessors, PowerPoint 2002 and 2000. PowerPoint 2003 also provides a number of enhancements that makes it even easier to create eye-catching and informative presentations.

Some of the new features provided by PowerPoint 2003 are as follows:

- **Package to CD**—This new feature is used to write a PowerPoint presentation directly to a CD. When the CD is created, a copy of the new PowerPoint Viewer is also placed on the CD to allow you to easily play the presentation on any computer. Packaging a presentation on a CD is discussed later in this lesson.

- **New Slide Show Toolbar**—The Slide Show toolbar provides easy access to slide show tools such as the pen and highlighter options. The Slide Show toolbar is discussed in Lesson 12, “Presenting an Onscreen Slide Show,” which is in the PowerPoint section of this book (Part VII).


PowerPoint File Format Issues

By default PowerPoint presentations saved in PowerPoint 2003 are saved using the presentation file format that is compatible with PowerPoint 2002 and 2000. If you are upgrading from a version of PowerPoint that precedes PowerPoint 2000, you should be aware of some file compatibility issues.
For example, when you open a PowerPoint presentation saved in PowerPoint 97 or 95, the presentation will be upgraded as it is loaded by PowerPoint 2003. You can then save the presentation in the newer presentation file format (the standard for PowerPoint 2000, 2002, and 2003). If you are planning on editing or playing a presentation on a computer that is running a pre-2000 version of PowerPoint, you can save the presentation in a legacy file format (“legacy” simply means an older file format).

To save presentations in a pre-2000 file format, follow these steps:

1. With the presentation open in the PowerPoint window, select File, then Save As. The Save As dialog box opens (see Figure 5.1).

![Figure 5.1](image)

**Figure 5.1** Use the Save As dialog box to save a presentation in a legacy file format.

2. Click the Save as Type drop-down box and select the PowerPoint 95 or PowerPoint 97 file format (see Figure 5.1).

3. Change the filename if you want. Click Save to save the file.

### Packaging a Presentation to a CD

For those of you who used the Pack and Go feature provided by previous versions of PowerPoint, PowerPoint 2003 has upgraded the feature to the Package to CD tool. It allows you to quickly place a presentation on a CD. The process also includes the copying of the PowerPoint Viewer to the CD. You can then play the presentation on any Windows computer.
To package a presentation to a CD, follow these steps:

1. Place a writable CD (a CD-R or CD-RW disc) in your CD-RW drive. With the presentation you want to package open in PowerPoint, select File, then Package for CD. The Package for CD dialog box opens (see Figure 5.2).

2. Type the name for the CD in the Name the CD box (if you want).

3. If you want to add additional files or other presentations to the CD, click the Add Files button. The Add Files dialog box will open.

4. Select additional files using the Add Files dialog box and then click Add. The files will be added to the file list in the Files to Be Copied area of the Package for CD dialog box.

   Tip: PowerPoint Viewer Added to CD by Default The PowerPoint Viewer is added to the CD by default. If you do not want to include the viewer on the CD, select the Options button in the Package for CD Dialog box. Clear the PowerPoint Viewer check box in the Options dialog box and then click OK.

5. When you are ready to copy the presentation (and any additional files), click the Copy to CD button.

The presentation and any other files are copied to the CD. A message box will appear asking if you want to copy the files to another CD; click No to complete the process. When you open the CD files in Windows Explorer, you will find that the presentation has been copied to the CD (and any other files that you specified) along with the pptview file, which is the PowerPoint Viewer file (other files, such as some bearing the .DLL extension, which are required for the Viewer, are also copied to the CD). The CD is also written to autorun. This means when you place the CD in the computer, the PowerPoint Viewer automatically opens your presentation as a screen presentation.
Upgrading to Publisher 2003

In this lesson, you learn what’s new in Publisher 2003.

What’s New in Publisher 2003?

Publisher 2003 provides an easy-to-use environment for creating personal and business publications. Publisher 2003 provides an environment similar to that in previous editions of Publisher, but it also provides enhancements that make creating publications even easier.

Some of the enhancements to Publisher 2003 are as follows:

- **New Master Design Sets**—Master design sets allow you to create a family of publications such as envelopes, business cards, and stationery that share the same color and design elements. Master design sets are discussed in Lesson 3, “Using Design Sets,” in the Publisher section of this book (Part VIII).

- **New Publication Types**—PowerPoint 2003 also provides support for several new publication types. New greeting card and invitation templates are provided, and PowerPoint now allows you to quickly create CD/DVD labels and e-mail publications such as an e-mail newsletter. E-mail publications are discussed later in this lesson.

- **New Publication Task Pane**—The redesigned New Publication task pane allows you to quickly select a new publication from several different categories such as Publications for Print, Design Sets, and Blank Publications.

- **Commercial Printing Features**—Features used to prepare a publication for commercial printing have also been enhanced in PowerPoint 2003. Some of these features are discussed in Lesson 11, “Printing Publisher Publications,” in Part VIII of this book.

Publisher also embraces a number of enhancements that are common to the Office 2003 applications such as the Research task pane and Office 2003 Help system. New features found in Office 2003 are discussed in Lesson 1, “What’s New in Office 2003?” and the help system is discussed in Lesson 5, “Getting Help in Microsoft Office.” Both of these lessons are found in Part I of this book.
Upgrading From Publisher 2000 or Earlier?  If you are upgrading to Publisher 2003 from Publisher 2000 or earlier, you will need to become familiar with task panes and other features that have been recently added to the Office suite. Check out the lessons in Part I of this book before working through the lessons in the Publisher section (Part VIII) of this book.

Creating E-Mail Publications

One of the enhancements to Publisher 2003 is the availability of a number of new publication types. One of the new categories of publications is the e-mail publication. You have probably noticed that you get newsletters, flyers, and a variety of other publication types as e-mail. Publisher now makes it easy for you to create these special electronic publications. Let’s look at how you create an e-mail publication. The basics of creating other publication types are covered in Part VIII of this book.

Follow these steps:

1. In the Publisher window (select Start, All Programs, Microsoft Office, then Publisher to open Publisher), select Web Sites and E-Mail in the New Publication task pane.
2. Select E-Mail. The e-mail publication templates will appear in the Publisher window (see Figure 6.1).

![Figure 6.1](image) A number of e-mail publications are available in Publisher.
3. Select the e-mail publication template you want to use to create your new publication.

The new publication will appear in the PowerPoint workspace. You can now edit the template (replacing placeholder text with your own text) and add images to the publication. Completing a Publisher publication is discussed in Lesson 5, “Working with Existing Publications,” which is found in Part VIII of this book.

**Publisher File Format Issues**

You can become familiar with the Publisher 2003 interface and the tools that have been added to this most recent version of this popular desktop publishing tool by working through the lessons in Part VIII of this book. If you are planning on sharing Publisher files with users who still use previous versions of Publisher, or you plan on using a previous version of Publisher on another computer, there are some compatibility issues that you should be aware of.

Publisher 2003 uses a default file format that is also compatible with the 2002 version. If you plan on creating publications and then sharing them with users who use previous versions of Publisher, such as Publisher 2000 and 98, you will have to save the completed publication in a different file format.

To save a Publisher 2003 publication in a different file format, follow these steps:

1. In the Publisher window (with the publication open), select File, then Save As. The Save As dialog box will open (see Figure 6.2).

![Figure 6.2](Use the Save As dialog box to save Publisher files in different file formats.)
2. Select the **Save as Type** drop-down box and select the file format that you want to save the file in (such as Publisher 98 or Publisher 2000).

3. You can change the filename or use the **Save In** drop-down box to specify a new location to save the file.

4. Click **Save** to save the file (in the new file format).

After the file is saved in the legacy format (meaning older file format), you can provide the file to users of previous versions of Publisher.